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Introduction

Digimarc for Packaging is an extension for Adobe® Illustrator® that enables production designers and premedia professionals 
to create connected packaging by enhancing packaging artwork with Digimarc digital watermarks.

Essential Concepts
Digimarc for Packaging enables you to apply a digital watermark to layers of artwork in an Illustrator file. Linked or 
embedded TIF, EPS, JPG, PSD, PNG, and vector artwork files are supported for enhancement without embedding or 
rasterizing the original artwork elements. See Image Type Limitations for specific file types that can't be enhanced.

When you enhance a layer, a digital watermark is applied to a duplicate of the original layer, leaving the original layer 
unchanged, enabling you to experiment with different enhancement techniques and parameters to achieve optimal 
readability with minimal visibility of digital watermarks. The duplicated layer is automatically rasterized to 300ppi and 
embedded into the document.

Related Reading
For more information about enhancing packaging with a Digimarc digital watermark, see the following guides:

Techniques for Enhancing Packaging with Digimarc Barcode presents techniques for those enhancing packaging.

Enhancing Your Brand with Digimarc Barcode discusses Digimarc technology and its interactions with printing 
processes, package design, scanners, smartphone cameras, and more.

Contact Digimarc for a copy of these documents.

System Requirements
Digimarc for Packaging requires:

Multicore Intel processor with 64-bit support or Apple silicon processor in Rosetta emulation mode

Note
If you're using a computer with an Apple silicon chip, see Run Digimarc for Packaging in Emulation Mode 
on Apple Silicon for instructions.

macOS 11 (Big Sur), macOS 12 (Monterey), or macOS 13 (Ventura)
Adobe Illustrator 2021 or newer
16 GB RAM
100 MB hard disk space available for installation
Internet connection and a   My.Digimarc account

Document Conventions

Following are the standards and conventions used in this documentation. See the Glossary for terms related to digital 
watermarking.

Convention Description

Numeric format
The fractional part of a numeric value is represented by the period character, 
such as pi =~ 3.14

Elements in the user interface Formatting: Text in bold

•

•

•

•
•
•
•
•

http://my.digimarc.com
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•
•

Convention Description

Titles of panels and dialogs Formatting: Text in italics

User input (text that a user types) Formatting: Text in a monospace font

File and directory paths Formatting: Text in a monospace font

Variables or variable data Formatting: Text in italics, often within angle brackets (< >)

Tip
Tips provide 
helpful 
information.

Note
Notes bring 
additional 
information to 
your attention.

Warning
Warnings point out 
important 
information not to be 
overlooked.

Caution
Cautions point out 
critical information that 
could be detrimental or 
essential to success.

Install the Extension
Follow the Adobe Illustrator instructions for installing extensions. When you install Digimarc for Packaging v1.7.1, you must 
agree to the software license agreement. Click Agree to complete the installation.

Restart Adobe Illustrator after installing the extension.

Metadata Migration
After installing Digimarc for Packaging v1.7.1, all previously enhanced art files undergo a data migration when they're first 
opened.

If an art file is associated with two or more enhancement jobs, you're prompted to choose from a list of jobs. Any DM 
layers are deleted from the art file, and all enhanced elements are reverted and must be re-enhanced.
If an art file is associated with only one job, the Details are displayed and all enhanced layers remain intact.

Launch the Extension
To open Digimarc for Packaging, navigate to Window > Digimarc > Digimarc for Packaging.

Product Help

To see the product help within Illustrator, navigate to Help > Digimarc > Digimarc for Packaging.

Digimarc Support
For help using the Digimarc for Packaging, contact support.

 Digimarc Support Website
Send email to Digimarc Support

•

•

https://help.digimarc.com/
mailto:customer.care@digimarc.com
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Sign In to the Packaging Module

The first time you launch Digimarc for Packaging, you're prompted to sign in to the Packaging Module.

To sign in:

1 Enter an Email address and Password associated with the account that has access to the jobs to be added to the 
artwork.

2 Click Continue.

If you have problems signing in, contact your Packaging Module administrator for help.

After you sign in, your credentials are stored. The next time you open Adobe Illustrator and choose Window > Digimarc > 
Digimarc for Packaging, the extension automatically signs into the Packaging Module plugin using your stored credentials.

Automatic Updates
After you sign in, Digimarc for Packaging automatically looks for updates to the extension. There are two kinds of updates:

Optional: If an optional update is available, you see a message across the bottom of the panel.

Required: If a required update is available, you can't proceed until you've installed the update.

Click Update Now to install the new version.

Sign Out of the Packaging Module

After completing your work, you can sign out of the Packaging Module or stay signed in. If you sign out, your stored 
credentials are removed and you must sign in again to continue working with digital watermarks.

To sign out of the Packaging Module:

1 Click the Digimarc for Packaging panel menu (   ).

2 Select Sign Out. Your stored credentials are removed.

•

•
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Search

The Search panel is displayed if you're working with an art file that doesn't already have a Digimarc digital watermark
associated with it.

Use the Search function to find the enhancement job to use for the file. Keep in mind:

You can search by Job Name, Job ID, or GTIN/UPC-E/GIAI.
The search is case-insensitive.
Searches by GTIN, UPC-E, or GIAI must be 8–17 characters 
long and contain only numbers.
For Job Name and Job ID searches, you can use 
alphanumeric characters in the search terms, including 
accented characters.
Disallowed characters include  < > ¬ ± × ÷ and emojis.
Job Name search terms are limited to 300 characters (bytes).
Job ID search terms are limited to 256 characters (bytes).
Multi-byte characters, such as accented characters and those 
used in Chinese, Japanese, and Korean, could limit the length 
of the allowable search terms. 
If no jobs match the search term, a notice is displayed in the 
Search panel.

To search for an enhancement job:

1 Select whether to search by Job Name, Job ID, or the GTIN, UPC-E, or GIAI identifier.

To search by Job ID, provide the complete Job ID. This is an exact match search. For example, if the Job ID 
you want to use is 123ABC456, searching for 123ABC doesn't return the desired job.

Note
The Job ID isn't a required field in the Packaging Module and could be blank.

Job Name searches don't need to be exact, but the search text must be in the correct order. For example, if 
you want to use a job named ABC123DEF, a search for C123 returns the desired job, but a search for D123E 
doesn't. Only the Job Name field is searched; if you search for a Service Name that shares no common terms 
with the Job Name, no results are returned.

Searches by GTIN, UPC-E, or GIAI don't need to match entirely, but the search text must be an exact 
substring. For example, if you want to use GTIN 00000123456789, a search for 00123456 returns the desired 
job, but a search for 00006789 doesn't.

2 Enter a valid search term.

3 Click Continue.

•
•
•

•

•
•
•
•

•

•

•

•
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Search Results
If a Digimarc digital watermark is found, or if the artwork already has a digital watermark associated with it, the Details panel 
opens. However, if the digital watermark has multiple jobs associated with it, the Search Results panel opens. Jobs are listed 
in order by their creation date, with the most recently created job at the top.

1 Select a job from the table to see its details.

2 With the desired job selected, click Continue.

If you don't see the desired job, or if any of the details are incorrect:

1 Update the digital watermark information on  My.Digimarc.

2 Return to the extension and click the Back icon (   ) to search again.

Tip
If your search returns over 30 results, a message is displayed warning you that your desired job might not be in 
the returned list. Refine your search to narrow the results.

Note
In some OS or Adobe configurations, you might have to double-click a job to select it. To select it by single-
clicking, first dock the Digimarc for Packaging panel to the Illustrator workspace, expand the panel, and make your 
selection.

Details
The Watermark Resolution is measured in watermarking elements ("waxels") per inch (WPI) and is set to 150 WPI (the 
default) or 75 WPI.

To change the resolution:

1 Click Change Resolution.

http://my.digimarc.com
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2 Select 75 or 150. The chosen resolution is preselected the next time you enhance a file.

3 Review the details and click Continue.

Note
After you continue to the Dashboard, the resolution can't be changed.
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The Dashboard

The Dashboard is where you manage artwork elements and their applied enhancement techniques.

New, unenhanced files have no artwork elements on the Dashboard. To add elements, see Applying an Enhancement. 

1 The panel menu (   ) allows you to sign out of the Packaging Module or change the enhancement job associated 
with the artwork.

2 The Elements section lists the selected elements and their enhancement status. Each element can have multiple 
enhancement techniques to target separations. A summary of techniques and the enhanced separations is displayed 
under each element’s name, including the multi-channel parameters for each technique (that is, CMY, CMYK, MYK).

Indicates the element or technique is configured and enhanced.

Indicates the element or technique contains at least one separation that is configured but unenhanced. This is 
typically a separation that has been enhanced and then reverted to its unenhanced state. If the main element 
icon is gray, one or more corresponding techniques were reverted. See Revert Enhanced Element or Technique.

  No icon indicates an unconfigured, unenhanced element.

Indicates Channel Mapping is on.

2.1 The Parameters summary reflects the enhancement settings specified in Enhancement Options:
S indicates the enhancement strength.
MD indicates the minimum dot percentage.
(Below), (Low), (Med), and (High) indicate the setting selected for Minimum Dot Blend Mode.
Zero Ink indicates Protect Zero Ink is selected.
HL indicates Reduce in Highlights is selected.

•
•
•
•
•
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DD indicates the dot density of a binary pattern.
DS indicates the dot size of a binary pattern.
Color chips indicate the separations involved in a technique. Move the cursor over the icons to see a 
tooltip with the separation names.

3 The Elements field displays the number of elements on the Dashboard.

4 The GTIN/UPC-E/GIAI field displays the Digimarc digital watermark associated with this art file. The Watermark 
Resolution field displays the Watermark Resolution previously selected in the Details panel. Click Back (   ) to see 
the Details.

5 Buttons are enabled only when applicable:
Add Enhancement Technique – Opens the Enhancement Options dialog to add an enhancement technique to 
the selected element. You can also reach this dialog by double-clicking an element.

Enhancement Technique or Edit Element Options

If an enhancement technique is selected, this button opens the Enhancement Options dialog where you 
can change the settings for the selected enhancement technique. You can also reach this dialog by 
double-clicking a technique.
If an element on the dashboard is selected, this button opens the Element Options dialog.

Revert Enhanced Element or Technique – Removes the enhancement from the affected separation(s). The 
selected technique or element’s status changes from blue to gray but saves the enhancement settings to the 
dashboard.

Tip
If you revert one or more enhancement techniques, we highly recommend you reapply them in the 
original order (from bottom to top). This ensures the inks and elements are assessed the same way as 
the original enhancement.

Go to Element – Selects the layer corresponding to the selected element in the Layers panel and Artboard. If 
the selected element has been enhanced, the enhanced layer is selected instead.

Add Targeted Element – Adds the currently targeted, qualified layer in the Layers panel to the Elements list.

Remove Element from Dashboard – Deletes the selected element or technique from the Dashboard. Enhanced 
layers and separations are also removed.

Error Messages
After an object is enhanced, if you make any of the following changes to the original object, the associated element on the 
Dashboard shows an error icon (   ):

Change an object’s position on the artboard
Change a fill or stroke color
Delete an object
Resize an object
Update an opacity mask
Update a linked file
Add or remove an object from a group

To resolve an error, update or replace all problematic enhancements from the Dashboard.

•
•
•

•

•

•
•
•
•
•
•
•
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Applying an Enhancement

Enhancement is the process of applying a Digimarc digital watermark to one or more artwork elements. New, unenhanced 
artwork has no elements on the Dashboard until you add them.

Add Artwork Elements
To add artwork elements to the Dashboard:

1 Select an artwork element to receive the enhancement.

2 Click Add Targeted Element to Dashboard (  ) from the toolbar. The element is added with a default name. 

3 Repeat these steps for each artwork element to be enhanced.

See Element Options for more information about artwork element options.

Apply the Enhancement to an Element
To apply an enhancement to an artwork element:

1 Select the artwork element on the Dashboard.

2 Click Add Enhancement Technique (  ). The Enhancement Options dialog opens. See Enhancement Options for 
more information about selecting the enhancement technique.

3 Apply the desired enhancement options. 

4 Repeat these steps for each artwork element to be enhanced.

After you click Apply in the Enhancement Options dialog:

The layer in the Layers panel that corresponds to the selected element is duplicated, and the new layer has _DM
appended to its name.

Digimarc digital watermark is applied in the duplicate layer, rasterized to 300ppi, and embedded into the art file. The 
following settings are applied to the DM layer:

Color Model: CMYK or Grayscale, as appropriate

Resolution: High (300ppi)

Background: Transparent

Anti-aliasing: Art Optimized (Supersampling)

Preserve spot colors: ON

Embedded

The original layer is unchanged.

If enhancement succeeds:

The enhanced duplicate layer is kept.
Any previously enhanced layer associated with the same original artwork is deleted.
The Dashboard is updated with any changes made to the enhancement technique and parameters in Enhancement 
Options.

•

•

-

-

-

-

-

-

•

•
•
•
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If enhancement fails:

An alert informs you of the reason.
The duplicate layer is deleted.
Any previously enhanced layer associated with the same original layer is untouched.
The Dashboard isn't updated with changes made in Enhancement Options.

Note
Enhancement fails only if the network connection is lost or if the original element already contains a Digimarc 
digital watermark.

If you want to change a digital watermark, see Replace a Digital Watermark.

Group Enhancement
You can enhance multiple objects with one dashboard element. To do this, target each layer or group, press Command + G
to group them together, and then add the group to the Dashboard. When you add a group to the dashboard and enhance it, 
the _DM layer includes an enhanced, rasterized copy of all the layers in the group. The original group is unaffected. After a 
group is added to the dashboard, no other layers within that group can be individually added for additional enhancement.

Note
You can't add a group from the top-most layer level to the Dashboard. A group must be nested at least one level 
to be added.

Additional Notes

The elements and settings on the Dashboard are saved when the art file is saved.
The list of elements on the Dashboard is kept up-to-date regarding changes to the Layers panel. For example, if a 
layer corresponding to an element on the Dashboard is deleted from the Layers panel, the element is deleted from 
the Dashboard.
If you revert one or more enhancement techniques, we highly recommend you reapply them in the original order 
(from bottom to top). This ensures the inks and elements are assessed the same way as the original enhancement.

•
•
•
•

•
•

•
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Replace a Digital Watermark

You can replace a Digimarc digital watermark in the artwork without removing existing enhancement options.

To change the digital watermark to be embedded in the artwork:

1 Select Change Watermark from the panel menu (   ). A dialog opens, warning you that the existing digital 
watermark will be removed from all enhanced artwork elements.

2 To continue, click OK. After the digital watermark is removed, the Search panel opens.

3 Select another enhancement job to apply to the artwork elements.

Any existing enhancement techniques are saved on the Dashboard, but they haven't been applied. They're shown with a 

gray Digimarc icon (   ). Those enhancements must be reapplied or removed (   ).

Reapply an Enhancement

To reapply an enhancement marked with a gray Digimarc icon (   ):

1 Select an unapplied enhancement technique for an artwork element.

Tip
We highly recommend you reapply the enhancement techniques in the original order (from bottom to top). 
This ensures the inks and elements are assessed the same way as the original enhancement.

2 Click Edit Enhancement Technique (   ).

3 Select the desired enhancement technique. See Applying Enhancement for more information.

Note
The watermark resolution can't be changed. The enhancement technique uses the previously selected 
resolution value.

4 Click Apply.

The Digimarc icon turns blue (   ) when the enhancement has been applied.

Tip
After replacing a watermark, use the Verify application to confirm the watermark's consistency. You can get the 
Verify application from the Downloads module at    My.Digimarc.

http://my.digimarc.com
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Element Options

Here, you can change the element's name and apply a clipping mask to vector elements.

Rename an Element
To change an element's name:

1 Select the element on the Dashboard.

2 Click Edit Element Options (   ). The Element Options dialog 
opens.

3 Type the new Name.

4 Click Apply. The name is applied to the element (the original layer) 
and the DM layer if it exists.

Automatic Clipping Mask
This setting is off by default and is available only for vector objects. To create a vector outline path for cleaner, less pixelated 
artwork:

1 Select the element on the Dashboard.

2 Click Edit Element Options (   ). The Element Options dialog opens.

3 Enable Apply Clipping Mask.

4 Click Apply.

This creates a clip group containing the clipping path layer and the enhanced (DM) layer. The clipping path automatically 
clips the DM layer to remove the pixelated raster edge from the rasterization process. If this option is turned off later, the 
clipping path layer is deleted and the DM layer is removed from the clip group.

Clipping Mask Example

Without Clipping Mask With Clipping Mask
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Enhancement Options

The Enhancement Options dialog presents a choice of enhancement techniques: Multi-Channel, Single Channel, or Binary 
Pattern. Depending on the chosen technique, the Enhancement Parameters can change. The multi-channel technique is 
selected by default if process channels are available in the image. If there are no process channels, the single-channel 
technique is selected by default.

Multi-Channel Enhancement

1 Select the Multi-Channel technique, and then select the color channels to enhance: CMY, CMYK, or MYK. The icon 
in the upper-right corner shows the selected channels. Options are shown as unavailable if any necessary colors have 
already been enhanced or aren't present.

2 Select the desired Enhancement Parameters:

Strength – Controls the strength of the Digimarc digital watermark.

When the watermark resolution is set to 150 WPI, the strength slider displays values in half-strength 
increments from .5 to 10.

When the resolution is 75 WPI, the strength slider displays whole values from 1 to 10.

Minimum Dot % – Specifies the Minimum Dot as supplied by your printer.

Note
Minimum Dot % and Minimum Dot Blend Mode settings default to those last used in the art file.

Minimum Dot Blend Mode – Compresses a range of pixels based on a preset curve. Based on the setting, 
compression is applied as pixels approach min dot, creating a blending effect in a specific range using the 
following formula:
 
 

•

-

-

•

•
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Below: Applies positive adjustments to pixels below the Minimum Dot % value.

Note
Pixel compression isn't supported for the Below setting.

Off: No compression

Low: (Min dot * 2) + 5

Medium: (Min dot * 2) + 10

High: (Min dot * 2) + 15

Protect Zero Ink – In channels with no ink, the digital watermark isn't added. This option is available only for 
multi-channel enhancement and is selected by default when min dot is above 0.

Reduce in Highlights – Available for CMY enhancement only if Minimum Dot Blend Mode isn't set to Below. 
This option minimizes enhancement in highlight areas. This reduces the need for art elements to go through 
an additional step of highlight reduction in Photoshop after enhancement in Illustrator.

Custom Data – The custom data associated with the job you selected in Search Results is shown here, if 
applicable.

3 To reveal the channel mapping panel, click Enable Mapping.

The channel mapping panel allows you to enhance any available non-process colors in the place of Cyan, Magenta, 
Yellow, or Black in a Multi-Channel technique rather than using a Single Channel technique. This can be beneficial 
because single-channel enhancements are often stronger and more visible than multi-channel enhancements, which 
blend multiple separations to output a smoother, less visible enhancement. The color chip icons dynamically update 
to display the separations involved in the output.

-

-

-

-

-

•

•

•
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Caution
Channel mapping is an advanced setting and is recommended for use by experienced enhancers with 
specific training from Digimarc. An expert-level understanding is critical to ensure the readability of the 
enhanced image. Contact Digimarc to schedule training if you're unfamiliar with this technique.

4 To enhance the selected element, click Apply, or click Cancel to exit without enhancing the element.

Single Channel Enhancement

1 Select the Single Channel technique, and then select the channel to enhance. Options are shown as unavailable if 
the color has already been enhanced.

2 The Enhancement Parameters are:

Strength – Controls the strength of the digital watermark.

When the watermark resolution is set to 150 WPI, the strength slider displays values in half-strength 
increments from .5 to 10.

When the resolution is 75 WPI, the strength slider displays whole values from 1 to 10.

Minimum Dot % – Specifies the minimum dot as supplied by your printer.

Minimum Dot Blend Mode – Compresses a range of pixels based on a preset curve. Based on the setting 
compression is applied as pixels approach minimum dot, creating a blending effect in a specific range using 
the following formula:

Below: Applies positive adjustments to pixels below the Minimum Dot % value.

Note
Pixel compression isn't supported for the Below setting.

•

-

-

•

•

-
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Off: No compression

Low: (Min dot * 2) + 5

Medium: (Min dot * 2) + 10

High: (Min dot * 2) + 15

Custom Data – The custom data associated with the job you selected in Search Results is shown here, if 
applicable.

3 To enhance the selected element, click Apply, or click Cancel to exit without enhancing the element.

Binary Pattern Enhancement

1 Select the Binary Pattern technique, and then select the channel to enhance. Options are shown as unavailable if the 
color has already been enhanced.

2 The Enhancement Parameters are:

Positive/Negative – Select a negative binary pattern (White dots on black) or a positive binary pattern (Black 
dots on white).

Dot Density – Set the density of the dot pattern.

Note
Dot Density 30 is the default for enhancing at 150 WPI. For enhancing at 75 WPI. The default is 40.

Dot Size – Set the size of the dot pattern.

Note
Dot Size 1.5 is the default for enhancing at 150 WPI. For enhancing at 75 WPI, the default is 2.

-

-

-

-

•

•

•

•
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Custom Data – The custom data associated with the job you selected in Search Results is shown here, if 
applicable.

3 To enhance the selected element, click Apply, or click Cancel to exit without enhancing the element.

•
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Known Limitations

Image Type Limitations
The following image types can't be enhanced:

Any non-grouped object with an Adobe Illustrator or Photoshop Effect

Any non-grouped single-channel object with a Gradient or Gradient Mesh

Workflows to Avoid After Enhancement

To avoid placing the artwork file in a state that exposes known issues, it is critical that designers complete the artwork 
design, layout, and layer structure before using the extension. Avoid the following post-enhancement workflows:

Undo (Cmd + Z)*

Deleting the original layer*

Color correction

Unembedding enhanced links

Embedding outside-enhanced links from other applications, such as Photoshop

Note
Items marked with an asterisk ( * ) are most relevant to prepress operators.

•

•

•

•

•

•

•
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Digimarc Color Advisor

Digimarc Color Advisor is an additional tool provided by Digimarc for Packaging. It helps production designers and prepress 
specialists:

Select the best spot colors with which to enhance packaging with Digimarc digital watermarks.
Decide how best to work with a given spot color for readability by barcode scanners.

These recommendations don't cover readability on mobile devices.

Open Digimarc Color Advisor by navigating to Window > Digimarc > Digimarc Color Advisor.

When you select a spot color, Digimarc Color Advisor displays the suggested technique for enhancing that color with digital 
watermarks. The Digimarc Color Advisor contains data for spot colors from the PANTONE+ Solid Coated or PANTONE+ 
Pastels & Neons Coated swatch libraries (PANTONE GP1501 Plus Series Formula Guide Coated or PANTONE GG1504 Plus 
Series Pastels and Neons Coated).

Note
Enhancement recommendations are supported for both 75 WPI and 150 WPI art files. If the art file doesn't contain 
a digital watermark, the default resolution is the last resolution applied.

150 WPI 75 WPI

Field Definitions

PANTONE® Color Name: The PANTONE MATCHING SYSTEM® is a tool allowing for the faithful selection, articulation, 
and reproduction of consistent, accurate color anywhere in the world. The tool organizes color standards through a 
numbering system and chip format.

Strength: The suggested technique assumes a default strength of 5. Use the slider to view suggestions for other 
enhancement strengths. Some colors can be enhanced better at certain strengths.

Red Light Contrast: Given as a percentage, this is the difference in reflectivity between paper white and solid ink of 
the light (670 nm wavelength) transmitted by barcode scanners. Contrasts between 20% and 80% indicate more 
easily enhanced colors.

Suggested Technique: This is a suggested starting point for working with a particular tint, based on offset printing on 
white, coated paper, and assumes a GRACoL2006 profile. Experiment with the techniques to find the one that works 
best for your particular color, substrate, and printing environment.

Spot Direct: Screened: This process varies the percentage of ink applied within areas covered by the spot 
color.

•
•

•

•

•

•

-
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Process Overprint: Multi-channel: This process adds low percentages of cyan, magenta, and yellow (CMY) 
inks over the spot color. The suggested CMY tints are listed as well as the DeltaE.

DeltaE: How noticeable the difference is between the overlay and the original spot color, where a DeltaE of 
2.3 is barely noticeable and higher DeltaE values are more noticeable.

Note
DeltaE is shorthand for the standard CIE ΔE*

ab, which is the Euclidean distance between two colors 
in the perceptually uniform device-independent color space, CIELAB.

-

-
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Run Digimarc for Packaging in Emulation Mode on Apple Silicon

If you're using a computer with an Apple silicon processor, you must run Adobe Illustrator in emulation mode to use Digimarc 
for Packaging.

To enable emulation mode:

1 Install Adobe Illustrator, but don't launch the application yet.

2 Install Digimarc for Packaging.

3 In /Applications/<Adobe Illustrator>, right-click the Adobe Illustrator folder, and select Get Info.

4 Enable Open using Rosetta. This setting must be applied only once.

5 Launch Adobe Illustrator.

6 Create or open an art file.

7 To confirm Digimarc for Packaging was properly installed, navigate to Window > Digimarc > Digimarc for Packaging.
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Version History

v1.7.1

The Adobe Illustrator extension now supports enhancement with secure identifiers. Contact Digimarc to learn more 
about this advanced feature.

The word "Barcode" was removed or replaced by "Watermark" in the UI when referring to the terms below:

Search

Resolution

Details

The Adobe Illustrator extension now has an in-app sign-in screen.

The Search functionality has changed. You can now search for enhancement jobs by Job ID, Job Name, or the GTIN, 
UPC-E, or GIAI number.

You can now change the digital watermark during the enhancement process.

v1.6.1

Fixed an issue where the Digimarc for Packaging extension would not load after installing Adobe Illustrator 26.3.1.

Added the ability for the extension to alert the user that an update is available.

v1.6

Added support for macOS 12 (Monterey).

Added support for Adobe Illustrator CC 2022.

Added telemetry reporting.

Updated Barcode Search criteria to no longer require adding zeroes before a code to make it 14-characters long.

Updated the Barcode Search Results panel to allow users to select the job to enhance, if multiple jobs are available.

Added more information to the Barcode Details panel:

More specific GTIN types

Custom data, if applicable

Job information, if applicable

Custom Data is now applied at the document level, instead of the element level.

v1.5

Digimarc Color Advisor

•

•

-

-

-

•

•

•

•

•

•
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•

•
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Added support for 150 WPI and 75 WPI spot color enhancement recommendations. The WPI used in Color Advisor 
reflects the WPI of the active document. If no WPI is applied, Color Advisor defaults to the last WPI applied to a file.

Enhancement recommendations are now generated from the 2019 PANTONE + Solid Coated/Uncoated and Pastels & 
Neons Coated books.

Adobe Illustrator Extension

Added support for enhancement of all image types, resolutions, linked, and embedded original artwork. See Essential 
Concepts and Applying an Enhancement for more information.

Added support for Group Enhancement.

Added a new Element Options dialog to support Auto-Clipping Masks for vector objects.

Added support for Dashboard Errors.

•

•

•

•

•

•
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Glossary

artwork

The elements of design and text that makeup packaging, labels, or other visual media, in which a Digimarc digital watermark 
is or will be included.

barcode

The generic term for an optically machine-readable pattern that encodes data in a way that is generally not recognizable to 
human observation. Barcodes include one-dimensional symbols that encode data into a machine-readable pattern of 
adjacent, varying width, parallel, dark rectangular bars and pale spaces, and 2-Dimensional Symbols that encode data in the 
X and Y-axes (sometimes referred to as a 2D barcode, for example, in the case of a QR Code, Data Matrix, and Digimarc 
digital watermarks.

binary pattern

A form of Digimarc Barcode consisting of a sparse pattern of dots.

DeltaE
How noticeable the difference is between the overlay and the original spot color, where a DeltaE of 2.3 is barely noticeable 
and higher DeltaE values are more noticeable. DeltaE is shorthand for the standard CIE ΔE*ab, which is the Euclidean 

distance between two colors in the perceptually uniform device-independent color space, CIELAB.

Digimarc Barcode

The Digimarc digital watermark.

Digimarc digital watermark
A novel data carrier that encodes data in media in ways that are generally imperceptible to people, permitting the carrier to 
be repeated many times over the surface of the Enhanced media. It delivers unprecedented ease of use, reliability, and 
efficiency in identifying the media due to massive mathematical and graphical redundancy.

digital watermark

In this guide, digital watermark refers specifically to the Digimarc digital watermark.

dot density
The density of dots per tile in a binary pattern expressed as a percentage of a maximum number of waxels that contain a dot. 
The maximum number of waxels that can contain a dot marking in a Tile of a binary pattern is 50%. A dot density of 20 
means that 10% (20%*50% of the waxels in a tile contain a dot marking.

dot size
The width of a dot in pixels at the enhancement resolution in binary enhancement. The enhancement resolution is expressed 
in pixels at a resolution in DPI. If the WPI is 75, and the enhancement resolution is 300 DPI, then there are 4 by 4 pixels per 
waxel. Dot size 2, for example, is a dot comprised of two by two pixels.

enhance

The process to integrate Digimarc digital watermark into a label or package artwork, enabling it for scanning.

enhancement

The result of creating and integrating a Digimarc digital watermark into product packaging and other substrates.

job

Jobs are used to track events and associated data about the production of packaging artwork. A Packaging Barcode (or 
Custom Data) can have one or more Jobs associated with it.



Guide to Digimarc for Packaging Extension for Adobe Illustrator 27

Version 1.7.1 221129

 

minimum dot

The minimum dot percent that can be held at press. Often abbreviated as "min dot." Min dot is affected by factors such as 
the printing process, different plating technologies, and the substrates being printed on. For example, a flexographic printer 
might have a min dot of 2, meaning a 2% dot is the smallest dot they can successfully print at press.

Multi-Channel Enhancement

A technique that applies Digimarc Barcode in plural color channels.

negative binary pattern
A sparse pattern of Digimarc Barcode comprised of light dots or holes in a darker background. A Negative Binary Pattern is 
not an inversion of the dark dots in a Positive Binary Pattern of the same Digimarc Barcode. Instead, this technique places 
light dots at the lightest Waxels within a Tile.

positive binary pattern

A sparse pattern of Digimarc Barcode consisting of dark dots on a lighter background. This technique places dark dots at the 
darkest Waxels within a Tile.

process color

A color comprised of percentages of cyan, magenta, yellow, and black (CMYK) typically printed with halftone printing plates. 
A type of color model, similar to additive color, which involves “process”colorsthat are a combination of cyan, magenta, 
yellow, and black, or CMYK inks. Eachprocess coloris comprised of percentages of cyan, magenta, yellow, and black inks. 
Extended gamut includes additional colors, such as orange, green, and violet. From Pantone: achieving color in printing is 
referred to as CMYK, four–color process, 4/c process or even just process. To reproduce a color image, a file is separated 
into four different colors: Cyan (C), Magenta (M), Yellow (Y), and Black (K).

Single Channel Enhancement

A technique that applies Digimarc Barcode in a single Color Channel.

spot color

A color generated by an ink (pure or mixed) that is printed using a single run. This is different from a process color, which is 
produced by overlaying a series of dots on multiple impressions using different colors.

strength

The suggested technique assumes a default strength of 5. Use the slider to view suggestions for other enhancement 
strengths. Some colors can be enhanced better at certain strengths.

substrate

The base material to be printed on.

tile

The fundamental unit of Digimarc digital watermarks, formed by combining an encoded message and Synchronization Signal 

in a two-dimensional area, which is repeated in whole or in part across artwork or a label.

validation

The process of checking that the data carried in Digimarc Barcode is both accurate and consistent. Also called verification.

validation point

The location in enhanced artwork that is designated for quality evaluation. The data validation process checks the GTIN 
carried in Digimarc digital watermarks, within an inspection area centered at this point, to determine whether the GTIN is 
correct and consistent with the GTIN in other areas and any 1D barcode in the artwork.

verification

The process of checking that the data carried in Digimarc Barcode is both accurate and consistent. Also called validation.
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watermarking element

A spatial cell in a tile to which a component of a message and synchronization signal can be mapped. Abbreviated as 
"waxel."

waxel

A spatial cell in a tile to which a component of a message and synchronization signal may be mapped. Waxel is short 
for "watermarking element." See "tile."

WPI

The resolution of a Digimarc digital watermark represented as waxels per inch.
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